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Getting Started 

 
1 Medis Suite Workspace 

This chapter covers the following topics: 

• Overview 

• Toolbars 

• Workspace panes 

• Central window 

1.1 Overview 

The main workspace of Medis Suite consists of toolbars, several workspace panes, and the central 
window area. 

  

You can customize the main workspace by hiding or moving the workspace panes and toolbars. Any 
changes that you make to the main workspace are saved for each Windows user. 

The central window area holds the Browser, View and Report tabs that are provided by Medis 
Suite. Next to that, the central window is the area where integrated Medis Suite applications will 
be displayed after launching them. 

  

Workspace panes 

Toolbars 

Central window 
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1.2 Medis Suite 

1.2.1 Menu 

The menu contains commands to activate the functionality that you need when you are working 
with Medis Suite. 

To make the menu visible: 

• Click on the menu icon  in the Main toolbar of Medis Suite. 

The menu commands are organized into seven main menus: Panes, Toolbars, Applications, 
Sessions, View, Tools, and Help. For some of the commands, tool buttons are available in the 
toolbars as shortcuts. 

 
Menu 

 
Command 

 
Function 

 

Panes Show or hide a workspace pane 

Toolbars Show or hide a toolbar 

Applications Start one of the Medis Suite apps 

External tools Start one of external tools 

Sessions Save or reset a Medis Suite session 

View Change the appearance of Medis Suite 

Tools Access to options and tools 

Help 
Access to user documentation and information about 
Medis Suite and all installed Medis Suite apps 

1.2.2 Toolbars 

The icons in the toolbars are shortcuts to frequently used menu commands. You can move toolbars 
to another part of the main window. You can also show or hide toolbars. 

To move a toolbar 

• Click on the double-bar grip handle  of the toolbar and drag it. 
 
You can now move the toolbar to any location on the sides of the main window. Simply 
click and drag the toolbar to its new position. The position of the toolbar is saved for a next 
session when you close the application. 
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To show or hide a toolbar 

1. Select  > Toolbars. 

2. Select a check box to show the toolbar, clear a check box to hide the toolbar. 

To reset the toolbar layout 

• Select  > View > Reset layout, or press F12. 

The state of the toolbars is saved when you close the application. 

 

 
Icon 

 
Function 

 
General Toolbar 

 

Show or hide the Medis Suite workspace panes 

 

Show user documents of Medis Suite and installed apps 

 
Applications Toolbar 

The applications toolbar shows buttons for all apps that are installed for advanced image analysis 
and/or your available licenses. Examples of apps include 3D View, QMass, QFlow, QFlow 4D, 
QStrain, QAngio XA and QAngio XA 3D.  

Some apps may provide multiple buttons in the toolbar, one for each supported analysis. 

   

External tools Toolbar 

The external tools toolbar will show the icons of the external tools that are configured in the 
Medis Suite options. 

 
Main Toolbar 

 

Close patient/study 

 
Select one of the available sessions 
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Icon 

 
Function 

 

Save / Save as of the active session 

 
Reset session 

 
Open the menu 

 

 

1.2.3 Workspace Panes 

By default, the workspace displays two panes on the left of the application area; the Series 
Browser pane and the Results pane. 

You can show or hide panes, dock panes, combine panes into one tabbed panel and remove panes 
from a panel. 

To show or hide a pane 

• Select  > Panes, and select a pane to show it. Clear its check box to hide it. 

To show or hide all panes 

• Click  in the General toolbar, or press F11 to show or hide all panes. 

To dock a pane 

1. Click and drag the title bar of the pane. 

2. Move the pane to the sides of the main window to select one of the dock areas. 
 
As the pane approaches a dock area, the area is highlighted with a dotted line. The pane 
can be combined with another pane or inserted separately. 

3. When the dock area of your choice appears highlighted, release the mouse button. 
 
This docks the pane into the selected position. 

To combine panes into one tabbed panel 

• Click and drag the title bar of the pane to the title bar of the pane with which you want to 
combine it. 
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This creates a tabbed panel. 

To remove panes from a panel 

• Click and drag the title bar of the pane away from the panel. 

To reset the panel layout 

• Select  > View > Reset layout, or press F12. 

1.2.4 Patient/Study – Series Info Panes 

The Patient/Study Info pane shows an overview of the patients in the active repository within 
Medis Suite. 

The Series Info pane shows an overview and detailed information of the series that belong to the 
active Patient/Study. 

 The Info panes show the data as combined in DICOM. The Series Browser pane shows the 
data after loading and sorting into Medis Suite. 

 

When selecting and activating the patient-study in the Patient/Study Info, the patient is loaded in 
Medis Suite with all data or, when sessions are available for that Patient/Study, the last stored 
session will be loaded. 

In the Series Info pane, the user can select and load 
data into Medis Suite via Drag ‘N Drop or via right 
mouse button. 

It is possible to delete data or initiate automatic 
contour detection on the selected data, using the 
context menu which is accessible via the right mouse 
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button. It is also possible to delete data or initiate automatic contour detection on the selected 
data.  

 The progress of the contour detection can be seen in the Status dialog. 

When the contour detection has finished the AutoQ session file will be added to the study and will 
be visible in the Series Info pane. 

1.2.5 Workflows 

Workflows enable starting a predefined group of applications with automatically pre-loaded data. 
The workflow button(s) are located between Patient/Study Info and the Series Info.  

The workflow button “Launch Analysis”, will start functional 
analysis applications and preload each application with 
corresponding data, if the data is available. The following steps will 
occur in Medis Suite. 

• QMass will be loaded with short axis and long axis data and if available a corresponding 
AutoQ session file.  

o The functional short axis and long axis analysis will be started. This will result in 
short axis and long axis functional results in the report. 

• QStrain will be loaded with short axis and long axis data and if available a corresponding 
AutoQ session file.  

o The strain short and long axis analysis will be started. This will result in strain short 
and long axis results in the report. 

• QFlow will be loaded with flow data. 

• The series data required for each type of analysis will be loaded in Medis Suite and shown 
in the Medis Suite Viewer. 

 Applications that have no corresponding series data will be automatically closed. 

 Support for custom workflows can be requested at Medis customer support. 

1.2.6 Series Browser Pane 

The Series Browser pane shows an overview and detailed information of the series that are loaded 
in Medis Suite. 

 The Series Browser pane is automatically activated when new or additional data is loaded 
into Medis Suite. 

 

The Series Browser can present all series in image view and text view. 

• The image view presents an overview of all series in an icon list. The overlay of each icon 
displays the following information: 
 

o The series number (e.g. S201) 
o The series description (e.g. SERVEY_BFFE) 
o The number of images contained in the series (e.g. 21) 
o The viewport in which the series is displayed (e.g. 1-2, row 1 and column 2) 
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When the View tab is active, the series displayed in the active viewport is highlighted with 
a white border. This highlight is not visible when the browser, report, or an app is active. 
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• The text view presents an overview of all series in a text list. Each item in the lists displays 
the following information: 
 

o The viewport number displaying the series (e.g. 1-2, row 1 and column 2) 
o The series number (e.g. 201) 
o For MR and CT series: The series description (e.g. SURVEY_BFFE) 
o For XA series: The acquisition angles (e.g. RAO 15, CRA 33) 
o The number of images contained in the series (e.g. 21) 
o The date and/or time of the acquisition (e.g. 8:50 AM) 

When the View tab is active, the series displayed in the active viewport is highlighted in 
bold text. This highlight is not visible when the browser, report, or an app is active. 

 

 

  If a series is displayed in multiple viewports, the first viewport number is displayed in the 
series browser, and appended with a ‘+’ character, e.g. ‘1-2+’. 

To activate the image view 

• Click the image view icon  on the Series Browser pane 

To activate the text view 

• Click the text view icon  on the Series Browser pane 
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1.2.7 Results Pane 

The Results pane shows all results that are available for the current session of the current study. 
The results are gathered from the Medis Suite viewer and the running Medis Suite apps. 

  When Medis Suite apps are closed, their accompanying results will be removed from the Medis 
Suite Results pane and the report. 

 

All Medis Suite results are grouped into paragraphs and sections. You can collapse and expand the 
sections and paragraphs of the tree by clicking “v” or “>” in the top-level nodes. 

You can set the visibility of the results in the Medis Suite report from the Results pane. 

To show or hide a result from the report 

• Click on the name or any of the values of the result to toggle its visibility. 

To show or hide a paragraph with all contained results from the report 

• Click on the name of the paragraph to toggle its visibility. 

To show or hide a section with all contained paragraphs and results from the report 

• Click on the name of the section to toggle its visibility. 

 

  Sections, paragraphs and results that are hidden in the report, are displayed in the Results 
pane with a grayed out and italic font. 

  The Results pane is automatically activated when you activate the report. 

1.2.8 Notifications 

Notifications from analysis that could impact the results will be 
shown on the bottom right of Medis Suite. They will disappear 
within a few seconds. The blue notification indicator indicates 

that there are ( ) or are not ( ) notifications that have not been 
visited in the Status dialog. 
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In the status dialog all sent notifications during the lifetime of the Medis Suite instance will be 
collected. 

 

  Only notifications that could impact the results are shown. 
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1.3 Browser 

The Browser tab in the central window of Medis Suite provides functionality to import, view, filter, 
load, export, delete, and anonymize data. 

Any data that you would like to process must be contained in a Medis Suite Repository. Local 
repositories are located on your local machine or network drive. Shared repositories are managed 
through a Medis Suite server. You can have one or multiple repositories to work with. All configured 
repositories are listed in the Repository drop down in the Browser. 

 The visibility of and access to each available Medis Suite repository can be allowed or 
blocked (role based access control) by your system administrator. 

 Export, delete, and anonymize data from a repository is functionality that can be allowed 
or blocked (role based access control) by your system administrator. 

 The Medis Suite repositories are not intended to be used for long term storage or archival 
of your data. Make sure that the image data, as well as the Medis Suite sessions and results 
are persistently stored and archived on another location, such as your PACS or VNA. 
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1.3.1 Repository configuration  

To configure the Medis Suite repositories: 

• Click on the dropdown icon next to the Load button  in the Browser, and select 
Configure… This will open the Options dialog in the Repository section. 

• Configure an existing repository, or add a local or remote repository. 

or 

• Click  > Tools > Options (or Server options for a server configuration) and choose 
Repository. 

• Configure an existing repository, or add a local or remote repository. 

1.3.2 Local Repository Configurations 

 

To add a local repository: 

• Click  to add a new repository. Click in the Location field and select “Browse…” to 
select the root folder of your data repository. Double click in the Name field to edit the 
repository name. 

By default, there is no size limit on a repository, which is depicted by “-”. A size limit can be 
configured for local repositories. If enabled, Medis Suite will clean up the repository every night by 
deleting the DICOM data that has not been used for the longest amount of time; recently accessed 
studies will remain in the repository. The cleanup will delete study by study from the repository, 
until the repository size meets the defined criteria. Only images will be removed, the Medis Suite 
sessions and results will never be cleaned and will always remain available in the repository. 

To define a size restriction of a repository in gigabytes: 

• Click on the field “Maximum size (GB)” and enter the number of gigabytes. 
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1.3.3 Shared Repository Configurations 

When Medis Suite is installed in a client-server configuration, repositories can be shared between 
workstations.  

On a client machine, in order to share a local repository, or to connect with shared repositories 
from other machines, Medis Suite must be connected to a Medis Suite server. 

To connect to a Medis Suite server: 

 

• Enter the computer name or IP address of the system that hosts the Medis Suite server. 

• Test the connection by clicking the Test services button. 

• Select the “Apply” button. 

 

Your local repositories can now be shared with other Medis Suite workstations. 

To share a local repository: 

• Select the check-box in the “Shared” column of the repository list. 

 

You can connect with remote repositories that are shared from other Medis Suite workstations. 

To add a remote repository: 

• Click  to add a new repository.  

• Click in the Location field and choose a repository from the list of shared repositories. 

 

1.3.4 Selecting a Repository 

To change the active Medis Suite repository: 

• Open the Browser pane and open the repository dropdown box to see all configured 
repositories. 

• Click on the name of the repository to activate it. For local repositories, the folder that is 
associated with the repository will be displayed directly underneath the dropdown box. 
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 The Medis Suite repositories are defined and available for all users on the computer system. 
Which repository is activated is saved for each individual Windows user. 

1.3.5 Import Data into Repository  

Data can be imported into the Medis Suite repository directly from the Browser. This is especially 
useful to import data from CD, DVD, USB, or any folder on your computer or network. 

 Importing data into a repository is functionality that can be allowed or blocked (role based 
access control) by your system administrator. 

Medis Suite will automatically keep track of all files that are in your repository folders, if they are 
imported by Medis Suite, received by the Medis Suite DICOM connectivity module, or removed from 
the Browser. 

 

To import data into the Medis Suite repositories: 

• Click on the dropdown icon next to the Load button  in the Browser and select 
Import….  

• Browse to the folder you would like to import and click Select Folder.  

• The folder and any sub-folders will be scanned to determine the number of files and the 
size of the data set to be imported.  

 

• A confirmation dialog box showing the number of files and the dataset size will be 
displayed. The contents of this dialog box will depend on the available resources. If there is 
sufficient disc space available for the repository: 
 

 
 
If the disk space is low, i.e. less than 10GB, but not yet critical: 
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In either case 
 

o If No is selected, then no further action will be taken, and you will be returned to 
the Browser. 
 

o If Yes is selected, then the dataset will be scanned, to identify valid1 DICOM files. 
Only these files will be imported into the repository. 

 

• If there are insufficient resources available for the import, the following dialog will be 
displayed: 

 

 
 

In order to proceed with the import, extra storage must be made available. 
 

• During the import, a series of messages will appear in the message box indicating the 
current state of the import. On completion, the number of files that were imported and 
ignored will be displayed: 
 

 

 Files that are copied into or deleted from the repository folder, for example, by using the 
Windows Explorer, are not automatically detected by Medis Suite; a rescan of the 
repository is required to process such repository modifications. 

1.3.6 Rescan Repository 

To rescan the files in a Medis Suite repository: 

• Click on the dropdown icon next to the Load button  in the Browser and select 
Rescan. This will identify newly added or removed files. 

Or, 

• Press F5 with the Browser window active. This will identify newly added or removed files. 

 

1 A valid DICOM file is a DICOM file that has a valid study instance UID. 
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Or, 

• Press Ctrl+F5 with the Browser window active. This will rebuild the repository. 

 Note: If the active repository is a remote repository, Ctrl+F5 will rebuild the repository on 
the remote machine. For very large repositories this operation can take considerable time 
and it is therefore not recommended. Only ‘rebuild’ the repository to fix inconsistency 
errors in your repository that cannot be handled by a ‘rescan’. 

1.3.7 AutoQ 

Some of the Medis Suite apps provide preprocessing functionality, which is referred to as AutoQ 
algorithms. The AutoQ algorithms can be started manually, or automatically when data arrives in 
the repository. 

To launch an AutoQ algorithms manually: 

• Select one or multiple series in the browser. 

• Right-click the selection. 

• From the context menu, activate the AutoQ submenu, and the AutoQ algorithm of your 
choice. 

The AutoQ algorithm will be started and preprocessing on the selected series will be performed as a 
background process without any user input. In the meantime, you can continue to work with Medis 
Suite. 

Progress and status messages of the AutoQ algorithm will be presented in a separate tab which can 

be accessed by clicking on the AutoQ status button in the browser. An icon  is also shown in the 
status column of the browser to indicate that the AutoQ algorithm is in progress. When completed, 
any output of the AutoQ algorithm will be added to the series list, and can be loaded into Medis Suite. 

AutoQ algorithm can be connected with rule definitions that will check new data that arrives in your 
repository. If the data complies to the rule definitions (e.g. ‘has the data an MR short axes cine 
series?’) the corresponding AutoQ module will be started automatically. 

  Medis suite itself does not provide AutoQ algorithms, they are only installed with specific 
apps. 

  Automatic startup of AutoQ algorithms is disabled by default, and can be enabled for each 
repository in the Medis Suite options. 

  If your computer is connected with a repository coordinator (referred to as the server), Medis 
Suite will connect with the server to provide you access to the AutoQ algorithms that are 
installed on that computer. When you activate the AutoQ algorithms available on the server, 
it will be executed there, and it will not consume resources (CPU or memory) on your local 
system. For AutoQ modules from the server to show up in your browser, they should also be 
installed on your local system. 

 If you don’t see the AutoQ button in the browser or the AutoQ submenu in the context menu, 
there are no Apps installed that provide AutoQ algorithms. 
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1.3.8 Anonymization 

The data contained in the Medis Suite repository can be anonymized and exported from the patient 
study browser. 

 Anonymization data from a repository is functionality that can be allowed or blocked (role 
based access control) by your system administrator. 

To anonymize and export a patient study: 

 

• Select one patient study in the browser. 

• Right-click the selection. 

• From the context menu, select Anonymize. 

• Specify the desired new value for Patient Name and Patient ID. 

• Set the option to export to folder, or to repository. 
 
When exporting to a folder, set target path for the exported anonymized data. Medis Suite 
will create a new sub folder in this target path with the new patient name and patient ID, 
to export the output files. Optionally, Medis Suite can create a zip file with all anonymized 
data. 
 
When exporting to a repository, select the repository to export to, and specify a directory 
name that will be used in the repository to store the anonymized files. 

• Select Start to anonymize and export the data. 

  Anonymization will always include all data from the selected study, it is not possible to 
anonymize a subset of the data.  

  All DICOM Secondary Capture images of reports and snapshots will be excluded from the 
anonymization and export process, as they are likely to contain burned-in patient 
information. 

  The Medis Suite session data will be included in the anonymization process. However, 
snapshots and viewport layouts will be removed from the session data, as they are likely to 
contain burned-in patient information. Results provided by apps will only remain in the Medis 
Suite session data if the app can anonymize the results. In other cases, the results will be 
removed from the session. 
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1.3.9 Loading a Patient 

To search for a specific patient or study: 

• Edit the Patient/Study info filter by entering the filter text. 

•  

The Patient / Study list contents will be updated while you type. 

• To filter out any specific patient or study properties, click the filter combo box (default 
selection: All) and select the column on which you would like to filter. Filter text can be 
cleared by clicking the blue ‘X’ button.  

 

• To filter out studies on a specific date, click the study date box (default selection: Any 
date) and select the study date on which you would like to filter. 

me 

• To sort the patient / studies entries in the list, click on the header to sort in ascending (a 
to z) order. Click the header again to sort in descending (z to a) order. 

   

To load a patient / study in Medis Suite: 

• Select one patient / study entry in the list and click . 

Or, 
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• Double click on a patient / study entry in the list. 

 

  Medis Suite can only load data of one single patient / study. Loading a new patient / study 
will automatically unload any previously loaded patient / study. 

To load one or multiple series from a patient / study in Medis Suite: 

• Select one patient / study entry in the patient / study list. 

• Select one or more series in the series list 

• Click . 

Or, 

• Select one patient / study entry in the patient / study list. 

• Double click on one or more series in the series list. 

 

 The image files that are part of a patient / study can be exported, deleted, or anonymized. 
To start, right click on the appropriate entry in the patient / study list, and select the 
Export, Delete, or Anonymize menu item. 

   The export, delete and anonymize data from a repository is functionality that can be 
allowed or blocked (role based access control) by your system administrator. 

1.3.10 Loading Prior Exams 

To load prior exams of either the same or multiple patients, each prior exam is opened in a new 
instance of Medis Suite. 

To load a Prior Exam in Medis Suite: 

From the Browser, load the first study. 

• Select a patient / study entry in the patient / study list. 

• Select one or more series in the series list 

• Click . 

Load the next study as a Prior Exam. (This step can be repeated for multiple studies). 

• Select the second / study entry in the patient / study list. 

• Right-click and select “Load as Prior Exam...” 
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1.4 View 

The View tab in the central window of Medis Suite provides the viewing functionality. 

 

You can customize the viewer workspace by hiding or moving the workspace panes and toolbars. 
Any changes that you make to the viewer workspace are saved for each Windows user. 

1.4.1 Menu 

The menu contains commands to activate the functionality that you need when you are working 
with the viewer. 

To make the menu visible: 

• Click on the menu icon  in the General toolbar of the viewer. 
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The menu commands are organized into five main menus: Panes, Toolbars, Cine, Image Control, 
and Procedures, and one menu command: Initial view state. For some of these commands, tool 
buttons are available in the toolbars as shortcuts. 

  Menu commands may be grayed out when you are performing a procedure, such as a distance 
measurement. You can make the menu commands active by canceling or finishing the 
procedure. 

 
Menu 

 
Command 

 
Description 

 

Panes Show or hide a workspace pane 

Toolbars Show or hide a toolbar 

Cine Control the time point selection 

Image Control Set the image control 

Procedures Start a new procedure 

Initial View State Reset the view state (F12) 

1.4.2 Toolbars 

You can move toolbars to another part of the main window. You can also show or hide toolbars. 

 

To move a toolbar 

• Click on the double-bar grip handle  of the toolbar and drag it. 
 
You can now move the toolbar to any location on the sides of the main window. Simply 
click and drag the toolbar to its new position. The position of the toolbar is saved when you 
close the application. 

To show or hide a toolbar 

1. Click on the menu icon  in the General toolbar of the viewer and select Toolbars. 

2. Select a check box to show the toolbar, clear a check box to hide the toolbar. 

Or, 

1. Right-click in the toolbar area. This opens a context menu. 

2. Select a check box to show the toolbar, clear a check box to hide the toolbar. 

The state of the toolbars is saved when you close the application. 
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Icon 

 
Function 

General Toolbar 

 
Show the menu 

 

Go to the initial view state, reset zoom \ pan \ window width \ window level  

 

Select the viewport layout 

 

Select synchronization mode 

 

Enable / disable cross reference line 

 

Enable / disable cross reference cursor 

 

Close active viewport 

 

Close all viewports 

 

Toggle the visibility of the image overlay  

Cine Toolbar 

 

Go to the first time point 

 

Go to the previous time point 

 

Go to the next time point 

 

Go to the last time point 
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Icon 

 
Function 

 

Play a cine in a backward direction 

 

Stop the cine 

 
Play a cine in a forward direction 

 
Set the cine playback speed 

Mouse Controls Toolbar 

 

Stack 

 
Cine 

 
Zoom 

 
Pan 

 
Window width and window level 

Procedures Toolbar 

 
Calibrate the selected XA image 

 
Create a distance measurement 

 

Create an area measurement 

 

Create a text annotation 
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Icon 

 
Function 

 

Create a snapshot of the active viewport 

 
Create a viewport layout snapshot 

 
Copy all measurement results to the clipboard 

1.4.3 Workspace Panes 

By default, the workspace displays two panes to the right of the viewer; Procedures and 
Properties. 

You can show or hide panes, dock panes, combine panes into one tabbed panel and remove panes 
from a panel. 

To show or hide a pane 

• Click on the menu icon  in the General toolbar of the viewer, select Panes, and select 
a pane to show it. Clear its check box to hide it. 

To dock a pane 

1. Click and drag the title bar of the pane. 

2. Move the pane to the sides of the viewer window to select one of the dock areas. 
 
As the pane approaches a dock area, the area is highlighted with a dotted line. The pane 
can be combined with another pane or inserted separately. 

3. When the dock area of your choice appears highlighted, release the mouse button. 
 
This docks the pane into the selected position. 

To combine panes into one tabbed panel 

• Click and drag the title bar of the pane to the title bar of the pane with which you want to 
combine it. 
 
This creates a tabbed panel. 

To remove panes from a panel 

• Click and drag the title bar of the pane away from the panel. 



Getting Started 

Medis Suite 4.0 User Manual 28 

1.4.4 Procedures Pane 

The Procedures pane lists the different procedures, such as, measurements, annotations and 
snapshots that are performed on the series that is loaded in the viewport. 

 

You can collapse and expand the branches of the tree by double-clicking the top-level nodes. 

You can right-click a procedure to perform actions on the procedure. Depending on the type of 
procedure, you will get a context menu with several options. 

 

Locate: The image at which the procedure was originally performed will be 
activated. 

 Locate may be grayed out. You can make this menu item active by 
canceling or finishing the active procedure. 

Label: Change the label of the selected procedure. 

Copy to Clipboard: The annotation label, distance measurement and value, area 
measurement and values, or the snapshot image is copied to the 
clipboard. 

Remove: The procedure is deleted. 
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1.4.5 Properties Pane 

The Properties pane shows the properties of the selected procedure. 

To modify a Label 

1. On the Procedures pane, select the procedure (E.g. A measurement procedure). 

2. On the Properties pane, click the ellipsis  on the right of the Label field and select a 
predefined label, or type a custom label and press Enter. 

  

  

Or, 

1. On the Procedures pane, right-click on the procedure and select Label. 

2. Select a predefined label, or type a custom label and press Enter. 

 The predefined labels provided by Medis Suite are dependent on the modality of the active 
image data. 

Working with the Medis Suite viewer is explained in more detail in chapter 2. 
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1.5 Report 

The Report tab in the central window of Medis Suite provides the reporting functionality. 

 

1.5.1 Toolbars 

The positions and visibility of the toolbars in the Report tab are fixed. 

    

 

 
Icon 

 
Function 

Report Toolbar 

 

Show the graphical report 

 

Show the textual report 

 Set the separator of the textual report output 
 

 The separator selection is only active when the textual report is active. 
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Icon 

 
Function 

 

Clear the report by hiding all results 

Export Toolbar 

 

Select all exportable results 

 

Deselect all exportable results 

 
Export the selected exportable results 

 

More detailed information on working with the report and the export of results is given in chapters 
5.4 and 7. 
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2 Viewing 

2.1 Viewport 

The image viewport displays all images that are contained in the currently loaded series. 

 

The image overlay displays detailed information about the patient, the hospital, the image 
acquisition information, and the display settings. 

  When a series is “Lossy”, “Derived”, or “Resampled” this will be indicated as a warning in 
the image overlay at the bottom right corner of the viewport. 

 

To adjust the visibility of the image overlay 

• Click  in the general toolbar. 

• All image overlays will be hidden on the first click. Subsequent clicks will display the image 
warnings, display settings, image acquisition information, hospital information and patient 
information. 

 The visibility of the image overlay will always be restored on loading a new patient. 
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2.2 Viewport layout 

To adjust the viewport layout 

• Click  in the general toolbar. A table of rows and columns will appear. 

• Drag the mouse to determine the number of viewport rows and columns.  

 

• The viewport layout will be applied. 
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To clear a series from a viewport 

• Select the viewport. 

• Click  in the general toolbar.  

To clear all series from all viewports 

• Click  in the general toolbar.  

To enable or disable overlays in all viewports 

• Click  in the general toolbar, or press the Tab key. This will toggle off all overlays. 

• Continue to click  or press the Tab key to enable each sub-set of overlays. 

2.3 Loading Series 

Series can be loaded in the viewport from the Series Browser. 

To load series in the viewport 

1. Click an item in the image view or text view of the Series Browser to select it. 

2. Click and drag the selected series from the Series Browser to the viewport. 
 
This will load the series into the viewport. When multiple slices are contained in the series, 
the middle slice is displayed by default. When multiple time points are contained in the 
series, the first time point is displayed by default. The Series Browser highlights the 
displayed series with a white border around the icon in the image view, or bold text in the 
text view. 

3. Double click an item in the image view or text view of the Series Browser to select it. 

To review all series in the active study 

1. Press Page Down on your keyboard to load the next series into the viewport 

2. Press Page Up on your keyboard to load the previous series into the viewport 
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2.4 Navigation 

You can move forward or backward through the slices and time points in the series in several ways. 

To move forward or backward through slices 

Moving through slices can be done by using keys: 

• Press arrow up or down to move to the previous or next slice. 

Or, 

• Press HOME or END to move to the first or last slice. 

Moving through slices can be done by using interactive graphics: 

• Click or right-click the interactive graphics for slice (‘Sl’) on the viewport to move to the 
first or last slice. 

To move forward or backward through time points 

Moving through time points can be done by using buttons: 

• Click  or  on the Viewing toolbar to move to the previous or next time point. 

Or, 

• Click  or  on the Viewing toolbar to play a cine through the time points in 

backward or forward direction. Click  to stop the cine. 

Or, 

• Click  or  on the Viewing toolbar to move to the first or last time point. 

Moving through time points can be done by using keys: 

• Press the left or right arrow key to move to the previous or next time point. 

Or, 

• Press CTRL + left arrow, CTRL + right arrow to play a cine through the time points in 
backward or forward direction. Press Esc to stop the cine. 

Or, 

• Press HOME or END to move to the first or last slice time point. 

Moving through time points can be done by using interactive graphics: 

• Click the interactive graphics for phase (‘Ph’) on the viewports to move to the next time 
point. 
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Or, 

• Right-click the interactive graphics for phase (‘Ph’) and enter the desired number of the 
time point. 

2.5 Cross Referencing 

The scanline  and cross hair  tools enable the user to visually relate the active image 
and image position with that of the different series loaded in other viewports. Cross Referencing is 
visible when multiple related series are loaded. 

To enable/disable the scanlines 

• Click  in the general toolbar to enable or disable scanlines. 

 

To enable/disable the cross hairs 

• Click  in the general toolbar to enable or disable cross hair 

 



Working with Medis Suite 

Medis Suite 4.0 User Manual 37 

A cross hair reference of the same color implies there is an exact or nearby position cross 
reference. A different color cross hair indicates the position is out of range of the cross hair in the 
active image. 

2.6 Mouse Controls 

2.6.1 Stacking / Cine 

You can move through the slices and time points using Stacking (MR and CT images) or Cine (XA 

images) when you see the stack cursor . 

To activate the stacking or cine mouse control 

• Click  or  in the mouse controls toolbar. 

Or, 

• Select Stacking or Cine from the viewport context menu. 

To stack forward or backward through slices (MR and CT images) 

• Scroll the mouse wheel to stack through the slices. 

Or, 

• Click and drag the mouse forward and backward to stack through the slices.  

With either technique, if scrolling reaches either end it will stop at the first or last slice. 

 The current slice number is displayed on the scale overlay graphics in the viewport (‘Sl’). 

To stack or cine forward or backward through time points (MR, CT, and XA Images) 

• Scroll the mouse wheel to stack through the time points (only in a single slice series). 
 
If scrolling reaches either end of the time points, it will stop at the first or last time point. 

Or, 

• Click and drag the mouse left and right or down and up to scroll through the time points. 
 
If dragging reaches either end of the time points, it will loop to the first or last time point 
and continue stacking. 

 The current time point number is displayed on the scale overlay graphics in the viewport 
(‘Ph’ or ‘Frame’). 
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2.6.2 Zooming 

You can zoom in and out of the viewport using Zooming when you see the magnify cursor . 

To activate the zooming mouse control 

• Click  in the mouse controls toolbar. 

Or, 

• Select Zooming from the viewport context menu. 

To zoom in and out 

• Click and drag the mouse forward and backward to zoom in and out. 

Or, 

• Click and drag on the interactive labels of the scale overlay graphics. 

 The current zoom factor is displayed on the scale overlay graphics in the viewport. The 
value above the scale is the physical size of the scale. The number below the scale 
indicates the relative zoom: 100% means one display pixel equals one acquisition voxel. 

2.6.3 Panning 

You can move the image within the viewport left, right, up and down using Panning when you see 

the hand cursor . 

To activate the panning mouse control 

• Click  in the mouse controls toolbar. 

Or, 

• Select Panning from the viewport context menu. 

To pan the image 

• Click and drag the mouse in any direction. 

Or, 

• Middle-click and drag the mouse in any direction. 
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2.6.4 Window Width and Level 

You can adjust the window width and level (WWL) when you see the WWL cursor . 

To activate the window/level mouse control 

• Click  in the mouse controls toolbar. 

Or, 

• Select Window/Level from the viewport context menu. 

To adjust the window width and level 

• Click and drag 

o Right or left to increase or decrease the width. 

o Down or up to increase or decrease the level. 

Or, 

• Right-click and drag 

o Right or left to increase or decrease the width. 

o Down or up to increase or decrease the level. 

Or, 

• Click on the window width or level interactive graphics and drag up or down to increase or 
decrease the window width or level. 

Or, 

• Right-click on the window width or level interactive graphics and enter the desires values. 

 The current window width and level values are displayed in the lower-right overlay graphics 
in the viewport. 

Image Inversion 

You can invert the image view, i.e. turn blacks to whites and whites to blacks from the “Invert 
image” option in viewport context menu. 
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2.6.5 Initial View State 

To reset the zooming, panning and window width and level settings to the initial view state 

• Click  to reset the zooming, panning and window width and level. 
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3 Calibration of XA Images 

XA images may be accompanied by isocenter calibration information that allows Medis Suite to 
automatically calibrate the image data. If this information is not available or if the object to be 
measured is not in the isocenter, the images must be manually calibrated before measurements can 
be done on the images. Medis Suite supports isocenter calibration, catheter calibration, line 
calibration, manual calibration, sphere/circle calibration, or can take over calibration values from 
another acquisition. 

 The calibration of an XA image is automatically taken over and applied in Medis Suite and 
all running apps that have analyzed the same XA image. 

Errors in the calibration of an XA image can enlarge the subsequent measurement error. Therefore, 
the calibration procedure and the accuracy of its result have been topics of validation studies 
[1,2,3,4]. Using manual caliper measurements is superior to visual inspection (but inferior to 
stenosis analysis with automated edge detection methods) [5,6,7,8]. 

3.1 Performing Calibrations 

To start a calibration 

1. Select the viewport to calibrate. 

2. Click  in the toolbar, or select  > Procedures > Calibration. 

3. Select the calibration method and fill in the necessary information (see below). 

4. Click Done to finish and apply the calibration factor to the XA acquisition. 

This adds the calibration to the Calibrations list in the Procedures pane. At any time while the 
calibration is still active you can press Esc to cancel the calibration. 

3.1.1 Isocenter Calibration 

If isocenter data is available for the image, the default calibration method is Isocenter. No further 
actions are required to use isocenter calibration. 

 The isocenter calibration factor is only valid for measurements at the level of the 
isocenter. 
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3.1.2 Catheter Calibration 

You can use the known diameter of a catheter to calculate the calibration factor that is required 
for performing accurate measurements and analyses.  

The following selection criteria apply to catheter calibration: 

• The frame that shows the catheter must be acquired with the same image intensifier size 
and angulation/rotation as the frame in which measurements or analyses are to be 
performed. 

• The catheter must be shown with a minimum of motion. 

• The catheter must be contrast-filled, clearly visible, and with a minimum overlap of 
contrast agent in the aorta. 

• The catheter must be in the same plane as the measurements or analyses to be performed. 

• The part of the catheter shown must be more than 5 times the diameter to ensure 
accuracy. 

To perform catheter calibration 

1. Select Catheter as the Calibration method. 
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2. In the viewport, make sure to select the image that best meets the selection criteria for 
catheter calibration. 

3. Click in the image to specify the proximal point of the catheter, and then click to specify 
the distal point. 

 

4. Verify that the catheter contours are correct. 

5. Under Catheter Diameter, specify the known catheter size by selecting the size in French 
or typing the size in mm. 

 You can change the default catheter size. Click on the menu icon  in the General 
toolbar of the viewer, select >Tools > Options… and then select Calibration under Viewer. 
 

The calculated calibration factor and the coefficient of variation are shown. The 
coefficient of variation is an indication for the reliability of the calibration. You are warned 
if the variation coefficient exceeds the 8% threshold. When you get this warning, select a 
longer or straighter catheter segment. 

6. Click Done to finish and apply the calibration. 
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3.1.3 Manual Calibration 

If the image or image run does not include a calibration device, you can resort to specifying the 
calibration factor manually. 

 Results obtained from images that have manual calibration applied are less reliable than 
results obtained from images calibrated using a calibration device. 

To perform manual calibration 

1. Select Manual as the Calibration method 

 

2. Under Calibration factor, type the known calibration factor. Click outside the edit box or 
press Enter. 

3. Click Done to finish and apply the calibration. 

3.1.4 Sphere / Circle Calibration 

You can use the known diameter of a circular or spherical object to calculate the calibration factor 
that is required for performing accurate measurements and analyses.  

The following selection criteria apply to calibration based on circular objects, such as coins or 
spherical objects, such as billiard balls: 

• The frame that shows the circular or spherical object must be acquired with the same 
image intensifier size and angulation/rotation angles as the frame in which the 
measurements or analyses will be performed. 

• The circular object must be shown with a minimum of motion. 

• The frame that shows the circular or spherical object must be acquired at the same height -
being with the same distance to the image intensifier- as the object on which the 
measurements or analyses will be performed. 

To perform sphere/circle calibration 

1. Select Sphere/circle as the Calibration method. 
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2. In the viewport, make sure to select the image that best meets the selection criteria for 
sphere/circle calibration. 

3. Click in the image to specify the center of the circle/sphere and then drag to specify the 
diameter. 

 

4. Under Enter the diameter or volume, select whether you will be specifying the Diameter 
or the Volume. 

5. Type the diameter in mm or the volume in ml. Click outside the edit box or press Enter. 

 You can change the default circle diameter or sphere volume. Click on the menu icon  
in the General toolbar of the viewer, select Tools > Options… and then select Calibration 
under Viewer. 
 

The calculated calibration factor is shown. 
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6. Click Done to finish and apply the calibration.  

3.1.5 Line Calibration 

You can use the known length of an object (typically a ruler) to calculate the calibration factor that 
is required for performing accurate measurements and analyses.  

The following selection criteria apply to line calibration: 

• The frame that shows the calibration object must be acquired with the same image 
intensifier size and angulation/rotation angles as the frame in which the measurements or 
analyses will be performed. 

• The object must be shown with a minimum of motion. 

• The frame that shows the object must be acquired at the same height -being with the same 
distance to the image intensifier- as the object on which the measurements or analyses will 
be performed. 

• The part of the object of which the distance is measured should be parallel with the image 
intensifier. 

To perform line calibration 

1. Select Line as the Calibration method. 

 

2. In the viewport, make sure to select the image that best meets the selection criteria for 
line calibration. 

3. Click in the image to specify start point and then drag to specify the end point. 
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4. Under Enter the line length, type the distance in mm. Click outside the edit box or press 
Enter. 

 You can change the default line length. Click on the menu icon  in the General toolbar 
of the viewer, select Tools > Options… and then select Calibration under Viewer. 
 

The calculated calibration factor is shown. 

5. Click Done to finish and apply the calibration. 

3.1.6 Calibration from Other Acquisition 

If the image or image run does not include a calibration device, you can resort to using the 
calibration factor of a similar image of the same study that was calibrated using a calibration 
device. 

 You must make sure that both image runs were obtained using the same acquisition settings 
and that the measurements or analyses are in the same plane as the calibration device on 
which the original calibration was performed. 

To perform calibration from other acquisition 

1. Make sure that a catheter, line, sphere/circle or manual calibration is performed on one of 
the other images of the same study. 

2. Select From other acquisition as the Calibration method. 

 You can only select ‘From other acquisition’ if a catheter, line, sphere/circle or manual 
calibration is performed in one of the other acquisitions of this study. If no other 
calibration is available, the radio button will be disabled. 
 

3. Select the other acquisition from the list with series and instance numbers and acquisition 
angles. 
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The calibration method and calibration factor of the other acquisition are shown. You are 
warned if the acquisition time, image intensifier size, magnification or acquisition angles differ 
too much from the other acquisition. 

4. Click Done to finish and apply the calibration. 

  If the calibration in the other acquisition is modified, the calibration factor in the 
dependent image will also be updated. The calibration in the other acquisition cannot be 
changed to anything else than catheter, line, sphere/circle or manual. 

3.2 Editing Calibrations 

You can modify a calibration that was performed previously. 

To edit a calibration 

On the Procedures pane, right-click the calibration and select Edit from the menu. 

Or, 

While the viewport that contains the calibrated image is active, click  in the toolbar. 
 

 It is not possible to delete a calibration. However, if isocenter data is available for the 
image, you can edit the calibration and select Isocenter as the method to reset the default 
calibration. 
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4 Procedures 

Medis Suite supports the following procedures: 

• Annotations, 

• Distance measurements, 

• Area measurements, 

• Snapshots, 

• Viewport layout snapshots. 

4.1 Annotations 

You can add annotations to a viewport to mark it for analysis or to draw attention to specific 
details. Annotations are displayed in the viewport. All annotations of the active series are listed on 
the Procedures pane of the viewer. 

 

 When you navigate to another series, slice or time point, your annotation is no longer 
displayed in the viewport. This is because the point to which the annotation refers does not 
lie on the currently visible image. To see your annotation again, right-click on the 
annotation on the Procedures pane and select Locate; or double-click on the annotation on 
the Procedures pane. 

4.1.1 Creating Annotations 

To create an annotation 

1. Click  in the toolbar, or select  > Procedures > Text Annotation. 

2. Click and drag in the image to draw the annotation arrow. 

3. Select a predefined label, or type a custom label and press Enter. 

4. Click and drag the arrowhead or the text to adjust the exact location of the image that you 
want to mark. 
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5. Click outside the annotation. The graphic changes to white indicating it has left edit mode. 

This adds the annotation to the Annotations list in the Procedures pane. At any time while the 
annotation is still active you can press Esc to remove the annotation. 

4.1.2 Editing Annotations 

You can modify the text and location of annotations that were added previously.  

To edit annotation text 

1. On the Procedures pane, select the procedure. 

2. On the Properties pane, click the ellipsis  on the right of the Label field and select a 
predefined label, or type a custom label and press Enter. 

Or, 

1. On the Procedures pane, right-click on the procedure and select Label. 

2. Select a predefined label, or type a custom label and press Enter. 

To edit the annotation location 

1. Click the annotation graphic. 

2. Click and drag the arrowhead or the text to adjust the exact location of the image that you 
want to mark. 

4.1.3 Deleting Annotations 

You can delete any annotation that was added to a viewport. 

To delete an annotation 

• Click the annotation graphic and press Delete. 

Or, 

1. Select the annotation in the Annotations list in the Procedures pane.  

2. Press Delete on your keyboard or right-click and select Remove. 
 
This deletes the annotation. 

4.2 Distance Measurements 

You can measure the distance from one point to another. When you have measured a distance, you 
can modify the annotation and the end points of the measurement. All distance measurements of 
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the active series are listed on the Procedures pane of the viewer. All distance measurements of 
the active session are listed on the Results pane of Medis Suite. 

 

 When you navigate to another series, slice or time point, your distance measurement may 
not be displayed on the viewport. This is because the points between which you measured 
do not lie on the currently visible image. To see your measurement again, right-click on the 
measurement on the Procedures pane and select Locate; or double-click on the 
measurement on the Procedures pane. 

4.2.1 Creating Distance Measurements 

To measure a distance 

1. Click  in the toolbar, or press the D key, or select  > Procedures > Distance 
Measurement. 

2. Click and drag in the image from the start point of the measurement to the end point. 

3. Select a predefined label, or type a custom label and press Enter. 

4. Click and drag either arrowhead or the text to adjust the points of the image between 
which you want to measure. 

5. Click outside the measurement. The graphic changes to white indicating it has left edit 
mode. 

This adds the measurement to the Measurement list in the Procedures pane. At any time while 
the measurement is still active you can press Esc to remove the measurement. 

4.2.2 Editing Distance Measurements 

You can modify the text and location of distance measurements that were added previously. 



Working with Medis Suite 

Medis Suite 4.0 User Manual 52 

To edit distance measurement text 

1. On the Procedures pane, select the distance measurement. 

2. On the Properties pane, click the ellipsis  on the right of the Label field and select a 
predefined label, or type a custom label and press Enter. 

Or, 

1. On the Procedures pane, right-click on the distance measurement and select Label. 

2. Select a predefined label, or type a custom label and press Enter. 

To edit distance measurement end points 

1. Click the distance measurement graphic. 

2. Click and drag either arrowhead to adjust the points in the image between which you want 
to measure. 

4.2.3 Copying Distance Measurements 

You can copy the result values of a distance measurement to the clipboard as textual output. 

To copy a distance measurement 

• On the Procedures pane, right-click on the distance measurement and select Copy to 
Clipboard. 

The distance measurement label and value are copied to the clipboard. 

4.2.4 Deleting Distance Measurements 

You can delete any distance measurement that was added to a viewport. 

To delete a distance measurement 

• Click the distance measurement graphic and press Delete. 

Or, 

1. Select the distance measurement in the Measurements list on the Procedures pane.  

2. Press Delete on your keyboard or right-click and select Remove. 
 
This deletes the distance measurement. 
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4.3 Area Measurements 

You use the area measurement tool to draw and measure 2D areas. When you have measured an 
area, you can modify the area contour or annotation. All area measurements of the active series 
are listed on the Procedures pane of the viewer. All area measurements of the active session are 
listed on the Results pane of Medis Suite. 

 

 When you navigate to another series, slice or time point, your area measurement may not 
be displayed on the viewport. This is because the image on which you measured the area is 
not the same as the currently visible image. To see your measurement again, right-click on 
the measurement on the Procedures pane and select Locate; or double-click on the 
measurement on the Procedures pane. 

4.3.1 Creating Area Measurements 

To measure an area 

1. Click  in the toolbar, or press the A key, or select  > Procedures > Area 
Measurement in the menu. 

2. Click and drag to draw the area. The contour is automatically closed when you release the 
mouse button. 

3. Modify the contour as necessary (see Editing Area Measurements below). 

4. In the Properties pane, select the check boxes to include Area, Circumference, or Signal 
Intensity (SI) measurements in the image overlay. 

5. Click outside the contour. The graphic changes to white indicating it has left edit mode. 

This adds the measurement to the Measurement list in the Procedures pane. At any time while 
the measurement is still active you can press Esc to remove the measurement. 
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4.3.2 Editing Area Measurements 

To modify the contour 

1. Click the contour to make it active. 

2. Near the existing contour click and drag an altered contour. The alteration will be 
combined with the original. 

Or, 

1. Right-click on the contour and drag it, using the rubber-band tool  . 

2. Click outside the contour. The graphic changes to white indicating it is no longer in edit 
mode. 

4.3.3 Copying Area Measurements 

You can copy the result values of an area measurement to the clipboard as textual output. 

To copy an area measurement 

• On the Procedures pane, right-click on the area measurement and select Copy to 
Clipboard. 

The area measurement label and value(s) are copied to the clipboard. 

4.3.4 Deleting Area Measurements 

You can delete any area measurement that was added to a viewport. 

To delete an area measurement 

• Click the area measurement graphic and press Delete. 

Or, 

1. Select the area measurement in the Measurements list on the Procedures pane.  

2. Press Delete on your keyboard or right-click and select Remove. 
 
This deletes the area measurement. 

4.4 Snapshots 

You can save snapshots as evidence of a diagnosis. Snapshots are displayed on the Properties pane, 
and are listed on the Procedures pane. When a snapshot is created, you can modify the name at 
any time. 
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 When you navigate to another series, slice or time point, the annotations and 
measurements shown in the snapshot may not be displayed on the viewport. This is because 
the points at which the annotations and measurements were created do not lie on the 
currently visible image. To return to the same slice where a snapshot was created, right-
click on the snapshot on the Procedures pane and select Locate; or double-click on the 
snapshot on the Procedures pane. 

4.4.1 Creating Snapshots 

You can create a snapshot of the current state of the viewport. 

To save a snapshot 

1. Click  in the toolbar, or press the S key, or select  > Procedures > Snapshot. 

2. On the Properties pane, click the ellipsis  on the right of the Label field and select a 
predefined label, or type a custom label and press Enter. 

4.4.2 Deleting Snapshots 

You can delete any snapshot that was created. 

To delete a snapshot 

1. Select the snapshot in the Snapshots list on the Procedures pane.  

2. Press Delete on your keyboard or right-click and select Remove. 
 
This deletes the snapshot. 

4.5 Viewport Layout Snapshots 

You can save and restore the layout and state of all viewports by creating a viewport layout 
snapshot. The snapshots are displayed on the Properties pane, and are listed on the Procedures 
pane. When a viewport layout snapshot is created, you can modify the name at any time. 

4.5.1 Creating Viewport Layout Snapshots 

You can create a snapshot of the current viewport layout. 

To save a viewport layout snapshot 

1. Click in the toolbar, or select  > Procedures > Viewport Layout. 
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2. On the Properties pane, click the ellipsis  on the right of the Label field and select a 
predefined label, or type a custom label and press Enter. 

4.5.2 Deleting a Viewport Layout Snapshot 

You can delete a snapshot of a viewport layout. 

To delete a snapshot of a viewport layout 

1. Select the viewport layout snapshot in the Viewport layouts list on the Procedures pane. 
 

2. Press Delete on your keyboard or right-click and select Remove. 
 
This deletes the snapshot.  
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5 Medis Suite Apps and External Tools 

Where Medis Suite procedures provide basic image analysis and results, for advanced image analysis 
and additional results Medis Suite integrates dedicated applications, or ‘apps’. 

The clinical apps that are available in Medis Suite include QMass, QFlow, 3D View, QTavi, QAngio 
XA, QAngio XA 3D. Additional apps are released on a regular basis, visit the Medis website to learn 
more about our products. 

Medis Suite also supports apps for research use and/or investigation use only. These apps can be 
recognized by a purple color of the graphical user interface. Results of the research apps that are 
included in the Medis Suite report will be marked to be for research use and/or investigational use 
only. 

 Results from research apps should not be used for clinical decision making. 

5.1 Starting a Medis Suite App 

To start a Medis Suite app 

• Click on the app icon in the Applications toolbar. 
 
This will start the app without loading any series. 

Or, 

1. Right-click in the image viewport. 

2. From the context menu, select the app name. 
 
This will start the app, and load the series visible in the viewport into the app. 

Or, 

1. Select the series you want to load into the app in the Series Browser. 
 
Multiple series can be selected by holding the SHIFT or CTRL key. 

2. Right-click on one of the selected series in the Series Browser. 

3. From the context menu, select the app name. 
 
This will start the app, and load all selected series into the app. 

Or, 

1. Select the series you want to load into the app in the Series Browser. 
 
Multiple series can be selected by holding the SHIFT or CTRL key. 

2. Click and drag the selected series onto the app icon in the Applications toolbar. 
 
This will start the app, and load all selected series into the app. 
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When the Medis Suite app is started, it will be displayed on a new tab in the central window area of 
Medis Suite. The launched apps will be displayed after the View tab and before the Reporting tab 
in the order they were started. 

 Multiple instances of Medis Suite apps can be started. They will be running next to each 
other and can be identified by a sequence number ‘#1’, “#2’, etc. 

 Multiple versions of an app can be installed, for example QMass version 8.0 and version 8.1. 
You can configure how Medis Suite handles multiple app versions when reloading data from 

a session. Click  in the main Medis Suite toolbar, select Tools, Options and the select 
the General tab. 

Results from the Medis Suite apps will be visible in the Results pane of Medis Suite automatically or 
by actively pushing results from the apps to Medis Suite. Refer to the user manuals of the Medis 
Suite apps for more detailed information. 

5.2 Loading Series into Medis Suite Apps 

You can load series into Medis Suite apps that were already running, appending or replacing data 
that was already loaded. 

To load series into Running Medis Suite apps 

1. Click on the tab that holds the running Medis Suite app in the central window of Medis Suite 

2. Select the series you want to load into the Medis Suite app in the Series Browser. 
 
Multiple series can be selected by holding the SHIFT or CTRL key. 

3. Double-click one of the selected series, or click one of the selected series and drag the 
selection onto the running Medis Suite app.  
 
The series will be loaded by the Medis Suite app and the first series will be activated. 
 

 Press SHIFT during dragging to add the data to the running Medis Suite app without 
modifying the app’s series selection. 

 Press CTRL during dragging to unload previously loaded series from the Medis Suite app, and 
load the new series. 
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5.3 Closing a Medis Suite App 

To close a Medis Suite app 

• Click the ‘X’ on the tab that holds the running instance of the app. 
 

 

 When Medis Suite apps are closed, their accompanying results will be removed from the 
Medis Suite Results pane and the report. 

 When you switch to another patient or study in the Browser, all running Medis Suite apps 
will be closed. 

5.4 External Tools 

Medis Suite can be configured to launch 3rd party tools, for example to parse and process the results 
available in Medis Suite. External tools will not run embedded in the Medis Suite window on a tab, 
but will be launched to run independent from the Medis Suite environment. 

Before Medis Suite will launch an external tool, it can export sessions, reports, results, snapshots and 
movies that you can be used as input for the external tool. 

To start an external tool 

• Click on the external tool icon in the external tools toolbar. 

 

 Configuration of the external tools is performed through the “External tools” tab of Medis 
Suite options dialog. The configuration includes the location of the external tool, the icon to 
be displayed in the external tools toolbar or menu, optional command line parameters, the 
startup and shutdown properties, as well as the pre-launch export options. 

 Errors in the configuration of external tools or misuse of external tools can lead to 
unexpected results, such as data loss. Carefully verify that the proper information is 
exchanged between Medis Suite and the external tool. 

 Medis Suite provides an external tool template to export results into the CMR-COOP database. 
To use this external tool, you will require a CMR-COOP account and have to download the 
accompanying external tool from the CMR-COOP website and install it on your local system. 

 Medis Suite provides an external tool template to export results into the Cohesic database. 
To use this external tool, you will require a Cohesic account and have to setup our results 
gateway service to connect to the Cohesic server using your credentials. 
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6 Reporting 

All results available in Medis Suite, either from the Medis Suite viewer or from any of the running 
Medis Suite apps, within the active session of the active study can be used to generate a combined 
report. 

Next to the results from the Medis Suite viewer and the Medis Suite apps, the following sections can 
be included in the report: 

• Patient Study Info 

• Reason for Referral 

• Technique 

• Impressions 

• Extra-cardiac Findings 

• Miscellaneous 

• Comments 

• Conclusions 

6.1 Create a Report 

You can create a Medis Suite report from the Results pane, by showing or hiding results, paragraphs 
or sections from the report. 

     

To show or hide a result from the report 

• Click on the result name or any of the result values to toggle the visibility. 
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To show or hide a paragraph with all contained results from the report 

• Click on the paragraph name to toggle the visibility. 

To show or hide a section with all contained paragraphs and results from the report 

• Click on the section name to toggle the visibility. 

To hide all results from the report 

• Click  in the toolbar. 

To print the report 

• Click  in the toolbar. 

• Select the target printer and click OK. 

 

 Sections, paragraphs and results that are hidden in the report, are displayed in the Results 
pane with a grayed out and italic font. 

 The Results pane is automatically activated when you activate the report. 

 Your organization name and logo can be configured in the Medis Suite options. To open the 

options dialog, click  in the Main Medis Suite toolbar, and select Tools, Options. 

6.2 Modify a Report 

You can modify the following sections from the report: 

• Reason for Referral 

• Technique 

• Impressions 

• Extra-cardiac Findings 

• Miscellaneous 

• Comments 

• Conclusions 

To modify an editable section from the report 

1. Make sure the editable section is visible in the report. 
 
If the section is not visible yet, click on the section name to show it. 
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2. Click . 

 

3. Modify the section data by: 

o Remove, modify or add text using the keyboard. 

Or, 

o Click  to open a list of predefined labels and select one of the labels. 
 

 

By default, the label will be appended at the end of the text in the edit box. To 
insert the label at another location, select that location with your mouse first. 

4. Click  to close the edit box. 

 

  



Working with Medis Suite 

Medis Suite 4.0 User Manual 63 

6.3 Textual Report 

By default Medis Suite will show the report in a graphical layout. In addition, you can generate a 
textual report to allow copy-and-paste of results from Medis Suite to another application. 

To open the textual report 

• Select  from the report toolbar 

 The textual report only includes the results that are visible in the graphical report. To 
change the report content, modify the selections in the Results pane. 

To copy results from the textual report 

1. Press CTRL+A or select Select All from the context menu. 

2. Press CTRL+C or select Copy from the context menu. 
 
The entire textual report content is copied to the clipboard. 

Or, 

1. Select a part of the textual report content. 

2. Press CTRL+C or select Copy from the context menu. 
 
The selection is copied to the clipboard. 

 

You can paste the information to, for example, another report or spreadsheet with CTRL+V. It may 
be required to change the outlining of the textual report content to get a proper result. 

To change the outlining of the textual report content 

• Select  from the report toolbar and select one of the available outline 
options: 

- Spaces outlined 
- Space separated 
- Tab separated 

 To paste results into a Microsoft Excel workbook, use the Tab separated outlining, and past 
the results as text with the Paste special command of Microsoft Excel. 

To reopen the graphical report 

• Select  from the report toolbar. 
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7 Exporting 

From the Report tab you can export reports and results. 

 The export of the report and results is functionality that can be allowed or blocked (role 
based access control) by your system administrator. 

 

The following items are available for export from Medis Suite: 

• Report 

• Snapshots 

• Values 

In addition, the Medis Suite apps can add items to the export list, for example: 

• Images 

• Snapshots 

• Movies 

• Values 

The report, snapshots, images, and movies are displayed as a thumbnail in the export list on the 
Report tab. 

7.1 Select Results for Export 

You can select the report, snapshots, images, and movies from the export list to mark them for 
export. 

 



Working with Medis Suite 

Medis Suite 4.0 User Manual 65 

To include or exclude results for export 

• Click on a thumbnail image to include or exclude the result for export 

Or, 

• Click  to include all results for export. 

Or, 

• Click  to exclude all results for export. 

 Results that are included for export have a thumbnail that is visible in normal colors and is 
highlighted with a white border. Results that are excluded for export have a thumbnail that 
is grayed out and has no border. 

7.2 Export Results 

You can export all selected results in DICOM format to your repository or PACS for future review or 
reference. 

 The export targets and formats of the results can be set in the Medis Suite options. 

To export results 

• Click  to export the selected results. 

7.3 Export to Common Image Format 

Results can also be exported in common image formats.  

To export a single result into a common image format: 

• Right click on the result to export, and select Export… 

• In the Export dialog, select the output format, specify a filename, and click OK. 

To export a group of results into a common image format: 

• Select or deselect the results in the group you would like to export. 

• Right click on the header of the result group, and select Export selected… 

• In the Export dialog, select the output format, specify a filename, and click OK. 
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8 Sessions 

Status information of Medis Suite can be saved. The session can be reloaded to continue or review 
the image analyses performed by Medis Suite. 

Medis Suite sessions contain the following information: 

- The running Medis Suite apps. 
- All results from Medis Suite and the running Medis Suite apps. 
- The visibility status of all results in the report. 
- Information added to the editable sections in the report. 

If supported by the Medis Suite apps, sessions can also contain the following information: 

- The series loaded by the Medis Suite app. 
- Analysis settings and results (such as contours) created by the Medis Suite app. 

8.1 Working with Sessions 

Medis Suite can maintain multiple sessions for each study, but only a single session can be active at 
a time. All sessions can be accessed through the session combo-box in the Main toolbar. 

After loading a study, Medis Suite will automatically create a new session that is identified by the 
date and time on which the session was created, and your name. 

You can save sessions and create new sessions. Once loaded into Medis Suite, sessions cannot be 
removed. 

 A session is marked as modified whenever results are changed, the report content is 
changed, or Medis Suite apps are started or stopped. A modified session can be identified 
by an “*” displayed in the name. 

To save a Medis Suite session 

• Select  from the Main toolbar and click Save session 
 
The name of the session is updated to indicate that it is saved. 

Or, 

• Select  from the Main toolbar and click Save session as… 
 
Specify the name of the session and click OK. 
 
The name of the session is updated to indicate that it is saved. 

 

 Once a session is saved, its contents cannot be overwritten or modified by Medis Suite. 
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To reset a Medis Suite session 

• Select  from the Main toolbar. 
 
A new session is created. 

To select a Medis Suite session 

• Open the session combobox in the Main toolbar  and select the 
Medis Suite session. 

 When you switch or reset a session, all open Medis Suite apps will be closed and their 
results will be removed from Medis Suite. The Medis Suite apps that were contained in the 
newly activated session will be started and their results will be loaded in Medis Suite. 

 Before Medis Suite closes a modified session, you will be asked if you want to save the 
session. 
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9 Client-Server Software Updates 

In a Client-Server system setup, software updates for Medis Suite can be deployed from the server 
to the clients. 

An upgrade of a Medis Suite distribution, is started by upgrading the server installation of Medis 
Suite manually. Once the server is upgraded the client can be upgraded. 

On a client machine, when Medis Suite is started, a query will be sent to the server for a software 
update. In case of an available software update Medis Suite, on the client, will ask the user 
whether to upgrade immediately, or to postpone the software update. 

 

On the client, the update consists of the following steps: 

- A download of the software from the server takes place. 
- A progress / status dialog will be shown. 
- The active Medis Suite will be closed. 
- The software will be updated. 
- When finished the dialog shows the result. 
- Medis Suite will be started. 

 

 

 After the distribution update Medis Suite will automatically start. It is advised to directly 
perform the Post Install Test from the Tools menu. 

In case of errors during the update the status dialog will show the following information: 

- The error that occurred. 
- The path to the location of the logfiles of the software update process. 
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 Medis Suite installed in standalone mode does not support automatic updates. 

9.1 Options 

Client-Server options can be enabled or disabled from both the server side as for the client side. 
The default for Client and Server is enabled. The setting can be changed on the Options -> Services 
page. 

9.2 Troubleshooting software updates 

During a software update process a failure of the software update will be notified to the user via 
the progress and status dialog. 

 
 

 

 The path to the logging of the software update process is displayed on the dialog. The 
generic path is: "C:\ProgramData\Medis\Deployment\Logs\". For each update process there 
is a specific folder with logs. The logfile folder name is in the format of: 
Log_YYYYMMDD_HHMMSS (eg.  Log_20240709_171412).
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Medis Suite Services 

10 DICOM Connectivity 

Medis Suite supports the following DICOM services: 

• Echo SCU to test the DICOM connection with a remote DICOM node, such as a PACS. 

• Store SCP to receive data from a remote DICOM node, such as a PACS; 

• Store SCU to send data to a remote DICOM node, such as a PACS; 

• Find SCU and Move SCU to query and retrieve data from a remote DICOM node, such as a 
PACS. 

 

In order to create an efficient setup with DICOM connectivity, you can share the DICOM connectivity 
service on the Medis Suite server machine with one or more Medis Suite client machines. 

 

To configure the DICOM connectivity of the Medis Suite server 

• Go to the machine that acts as a Medis Suite server and start Medis Suite. 

• Click  in the Main Medis Suite toolbar, select Tools, Options and select the DICOM 
connectivity tab. 

 

To enable the Store SCP: 

 

• Select the check box “Enable the Medis Suite Store SCP…” 

• Set the appropriate AE title and port number for the Store SCP of Medis Suite. 

 The default settings are MEDISSUITE and port number ‘11112’. 

• Select the repository to store received data. 
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 In order to establish a successful connection, make sure to register the Medis Suite Store 
SCP with its AE title and port number on the PACS as a destination DICOM node. 

 

To enable the Store SCU: 

 

• Click  to add a new DICOM node. 

• Set the appropriate Remote AE title, port number, and machine name of the SCP on the 
PACS, and enter an appropriate node name. 

• Click  to test the newly defined DICOM node. 

• Select the newly defined DICOM node from the dropdown list of Export nodes. 

 

To enable the Find SCU and Move SCU to enable Query and Retrieve: 

• Click  to add a new DICOM node. 

• Set the appropriate Remote AE title, port number, and machine name of the SCP on the 
PACS, and enter an appropriate node name. 

• Click  to test the newly defined DICOM node. 

• Select the newly defined DICOM node from the dropdown list of Query/Retrieve nodes. 

 

To configure the DICOM connectivity of the Medis Suite client 

• Go to the machines that act as a Medis Suite client and start Medis Suite. 

• Click  in the Main Medis Suite toolbar, select Tools > Options, and select the Services 
tab. 
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• Enter the machine name or IP address of your Medis Suite server. 

 

• Click ‘Test services’ to verify the connection with your Medis Suite server. 
 

• The Medis Suite client machine will now be able to use the DICOM connectivity functionality 
from the Medis Suite server. 
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11 Query / Retrieve from PACS 

Medis Suite supports both Query and Retrieve from a predefined PACS. 

To query and retrieve from a PACS 

• Open the Browser tab, and click . The PACS tab will be opened. 
 

 
 

 The PACS button will only be visible and enabled when a DICOM node is configured for 
DICOM Query and Retrieve. 

 

Query a PACS 

• Using the Query fields to define the search criteria. 

• Click . 

• Matching patient and study information will be displayed in the list. 

 

Retrieve from PACS 

• Select an item from the list of patient and study information. 
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• Click .  

• The patient/study will be retrieved and appended to the repository. 

• Go to the Browser tab to confirm that the patient data is appended to the repository, and 
load the data into the Viewer. 

 

Clear results 

• Click  and the previous queried results will be cleared. 
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12 Audit Trail 

Medis Suite supports audit trailing functionality to maintain a log of relevant actions performed by 
Medis Suite or any of the integrated apps. 

In order to create an efficient setup with audit trailing, you can share the audit trailing service on 
the Medis Suite server machine with several Medis Suite client machines. 

To configure the audit trailing of the Medis Suite server 

• Go to the machine that acts as a Medis Suite server and start Medis Suite. 

• Click  in the Main Medis Suite toolbar, select Tools, Options, and select the Audit Trail 
tab. 

 

• Select the check box “Enable logging of audit trial messages” 

• Edit the directory where the audit trail must be stored. 

• Enable or disable the auto cleanup of audit trail files. 

 If you want Medis Suite to store data on a network drive, the Medis Suite Audit trail 
Windows service will require additional privileges that must be configured by your system 
administrator. Also, make sure to use the UNC network folder path (e.g. 
“\\machine\foldername”) instead of a drive mapping (e.g. “N:\foldername”). 

To configure the audit trailing of the Medis Suite client 

• Go to the machines that act as a Medis Suite client and start Medis Suite. 

• Click  in the Main Medis Suite toolbar, select Tools > Options, and select the Services 
tab. 

• Enter the machine name or IP address of your Medis Suite server. 

 

• Click ‘Test services’ to verify the connection with your Medis Suite server. 
 

• The Medis Suite client machine will now be able to use the audit trail functionality from the 
Medis Suite server. 
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Troubleshooting 

13 Troubleshooting 

Menu commands or toolbar buttons are disabled 

Menu commands or toolbar buttons may be grayed out when you are performing a 
procedure, such as a distance measurement. You can make them active again by canceling 
or finishing the procedure. 

Annotation or measurement is not visible 

When you navigate to another location in the volume, your annotation or measurement may 
not be displayed on the viewport. This is because the point to which the result refers does 
not lie on the currently visible slice. To see your result again, right-click on the result on 
the Procedures pane and select Locate; or click on the result on the Procedures pane. 
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15 Shortcut Keys 

When you are working with Medis Suite, you can use several combinations of keys on your keyboard 
and mouse actions to quickly perform the following tasks. 

 Medis Suite and apps may use the same shortcut key for different functionalities. Which 
application handles your shortcut key is dependent on which application has ‘focus’. 

Press To 

Layout 

F10 Maximize or restore the active image viewport 

F11 Show or hide the workspace window panes 

F12 Reset toolbar and workspace window pane layout 

Image control 

Middle-click and drag, or 

Ctrl and drag 

Pan 

Ctrl+Shift and drag Zoom 

Alt+Shift and drag Stack 

Ctrl+I Invert image 

Procedures 

D Create a distance measurement 

A Create an area measurement 

H Hide the graphics in the image viewport 
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Press To 

S, or 

CTRL+SPACE 

Create a snapshot 

Esc Stop editing the procedure 

Delete Delete the currently selected procedure 

SHIFT+Delete Delete all procedures 

Navigation Controls 

HOME Display the first time point 

END Display the last time point 

Arrow up Display the previous slice 

Arrow down Display the next slice 

Arrow left Display the previous time point 

Arrow right Display the next time point 

CTRL+arrow left Play cine backward 

CTRL+arrow right Play cine forward 

Esc Stop playing cine 

Page Up Display the previous series 

Page Down Display the next series 
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